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Copyrights

Copyrights

© Cypress Semiconductor Corporation, 2013. The information contained herein is subject to change without notice. Cypress

Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress

product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted nor

intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an express

written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-

support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The

inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use

and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by

and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty

provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create

derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-

ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-

fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source

Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-

RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described

herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.

Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure

may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-

tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all

charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

PSoC and CapSense are registered trademarks of Cypress Semiconductor Corporation. PSoC Designer, SmartSense, and

CapSense Express are trademarks of Cypress Semiconductor Corporation. All other products and company names men-

tioned in this document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the

Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard

Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP Semicon-

ductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family of

products is one of the most secure families of its kind on the market today, regardless of how they are used. There may be

methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge, would

be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the security of

their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly

evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Safety Information

Regulatory Compliance

The CY8CKIT-038 is intended for use as a development platform for hardware or software in a

laboratory environment. The board is an open system design, which does not include a shielded

enclosure. This may cause interference to other electrical or electronic devices in close proximity. In

a domestic environment, this product may cause radio interference. In this case, take adequate

prevention measures. Also, do not use the board near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default

may affect its performance and cause interference with other apparatus in the immediate vicinity. If

such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-038, as shipped from the factory, has been verified to meet 

with requirements of CE as a Class A product.

The CY8CKIT-038 contains electrostatic discharge (ESD) sensitive

devices. Electrostatic charges readily accumulate on the human body

and any equipment, and can discharge without detection. Permanent

damage may occur on devices subjected to high-energy discharges.

Proper ESD precautions are recommended to avoid performance

degradation or loss of functionality. Store unused CY8CKIT-038

boards in the protective shipping package.

End-of-Life / Product Recycling

The end-of life for this kit is after five years from the date of

manufacturing mentioned on the back of the box. Contact your nearest

recycler for dispositioning the kit.
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Safety Information

General Safety Instructions

ESD Protection 

ESD can damage boards and associated components. Cypress recommends that you perform

procedures only at an ESD workstation. If one is not available, use appropriate ESD protection by

wearing an antistatic wrist strap attached to chassis ground (any unpainted metal surface) on your

board when handling parts.

Handling Boards

CY8CKIT-038 boards are sensitive to ESD. Hold the board only by its edges. After removing the

board from its box, place it on a grounded, static free surface. Use a conductive foam pad if

available. Do not slide board over any surface.
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1. Introduction

Thank you for your interest in the CY8CKIT-038 PSoC® 4200 Family Processor Module Kit. This kit

allows you to develop applications on various products such as the sensor-less e-bike, white goods,

field oriented control (FOC) motor control, and home appliances. You can also design your own proj-

ects with PSoC Creator™, the integrated design environment (IDE) for PSoC devices.

The CY8CKIT-038 Processor Module is a PSoC 4200 family processor module designed for the

CY8CKIT-001 DVK. PSoC 4200 is a family of programmable embedded system devices with an

ARM Cortex-M0 CPU. It combines programmable analog, programmable interconnect, and user

programmable digital logic with a high-performance ARM Cortex-M0 subsystem. 

1.1 Kit Contents

This kit contains:

■ CY8CKIT-038 processor module

■ I2C character LCD 

■ Quick start guide

■ Kit CD/DVD

You can purchase this kit and download the example projects at

http:/www.cypress.com/go/CY8CKIT-038

Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office

for help or visit www.cypress.com/support.

1.2 PSoC Creator

Cypress's PSoC Creator software is a state-of-the-art, easy-to-use software development IDE. It

introduces a hardware and software co-design environment based on classical schematic entry and

revolutionary embedded design methodology.

With PSoC Creator, you can:

■ Create and share user-defined, custom peripherals using a hierarchical schematic design.

■ Automatically place and route select components and integrate simple glue logic normally resid-

ing in discrete muxes.

■ Trade-off hardware and software design considerations allowing you to focus on what matters 

and get to market faster.

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler tool

chains, RTOS solutions, and production programmers to support PSoC devices.

For more information, visit the PSoC Creator web page.
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1.3 Additional Learning Resources

Visit www.cypress.com/Products/Programmable System-on-Chip for additional learning resources in

the form of datasheets, technical reference manual, and application notes. 

■ Beginner Resources: PSoC Creator Training

❐ Getting Started With PSoC 4

■ Learning from Peers: Cypress Developer Community Forums

1.4 Document Revision History 

1.5 Documentation Conventions 

Table 1-1.  Revision History

Revision PDF Creation 
Date

Origin of 
Change Description of Change

** 05/10/2013 SRYP Initial version of kit guide

*A 09/26/2013 SASH Updated images for PSoC Creator 3.0

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:

C:\ ...cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:

[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:

File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes Cautions or unique functionality of the product.
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2. Getting Started

This chapter describes how to install and configure the CY8CKIT-038 PSoC 4200 Family Processor

Module kit software. Chapter 3 shows you how to program the kit, Chapter 4 documents the hard-

ware features of the kit, and Chapter 5 explains the operation of the code examples. The Appendix

section provides the schematics, PCB layout, and bill of materials (BOM) associated with the kit.

2.1 CD/DVD Installation

Follow these steps to install the CY8CKIT-038 PSoC 4200 Family Processor Module Kit software:

1. Insert the kit CD/DVD into your PC’s CD/DVD drive. The CD/DVD is designed to auto-run. If auto-

run does not execute, double click AutoRun on the root of the CD/DVD.

2. After the installation is complete, the kit contents are available at the following location: 

<InstallDirectory>\PSoC 4200 Processor Module Kit\<version>

2.2 Install Hardware

No hardware installation is required for this kit. The processor module is designed to be used in con-

junction with the CY8CKIT-001.

2.3 Install Software

When installing the CY8CKIT-038 PSoC 4200 Family Processor Module Kit, the installer checks if

your system has the required software. These include PSoC Creator, PSoC Programmer, Windows

Installer, .NET, Acrobat Reader, and Keil complier. If these applications are not installed, the installer

prompts you to download and install them.

The following software needs to be installed that are specified in the CD/DVD:

■ PSoC Creator 3.0 or later

■ PSoC Programmer 3.19.1 or later

Note Select the Typical installation type for all installations.

Code examples are provided in the Firmware folder of the kit installer.

2.4 Uninstall Software

The software can be uninstalled using one of the following methods:

■ Go to Start > Control Panel > Programs > Uninstall Programs; select the Uninstall tab for 

Windows.

■ Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Man-

ager; select the Uninstall button next to the software that needs to be uninstalled. 
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Getting Started

2.5 Verify Kit Version

To know the kit revision, look for the white sticker on the bottom left, on the reverse of the kit box. If

the revision reads CY8CKIT-038 Rev **, then, you own the latest version.
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3. Kit Operation

The CY8CKIT-038 PSoC 4200 Family Processor Module Kit should be mounted on the CY8CKIT-

001 DVK. The serial wire debugger (SWD) interface is available for programming/debugging on the

processor module board, as shown in the Figure 3-1.

3.1 Programming CY8CKIT-038

This section provides details on how to program the PSoC 4200 family device by using the

"VoltageDisplay_SAR_DAC" example project.

Follow this procedure to program a project onto the PSoC 4200 family device:

1. Connect the PSoC 4200 family processor module on the CY8CKIT-001 DVK.

2. Apply the power to the CY8CKIT-001 DVK using either the battery connections or a wall power 

unit using 12-V AC adapter.

3. Connect the MiniProg3 to the processor module on the 5-pin programming header J5, as shown 

in Figure 3-1; then, connect it to the host PC’s USB high-speed port using a USB cable. 

Figure 3-1.  Connecting CY8CKIT-038 and MiniProg3 with CY8CKIT-001 DVK

Note Refer to CY8CKIT-001 PSoC Development Kit Board Guide for more details on connections. 
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Kit Operation

4. Open PSoC Creator. Click on the VoltageDisplay_SAR_ADC example project from the Kits 

folder present on the Start Page.

Figure 3-2.  Kit Projects in the PSoC Creator Start Page

5. Create a folder in the desired location and click OK.

6. The project opens up in PSoC Creator and is saved in that folder.

7. Go to the Tools menu select Options.

Figure 3-3.  Tools > Options
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Kit Operation

8. Go to Program/Debug.

Figure 3-4.  Program/Debug Option

9. Select Port Configuration and click MiniProg3.

Figure 3-5.  Select MiniProg3
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Kit Operation

10.Configure MiniProg3 using the following settings.

Figure 3-6.  MiniProg3 Configurations

11.Build the project by selecting the Build option.

Figure 3-7.  Build Option

12.Click the Program icon.

Figure 3-8.  Program Option

In some cases, when you click the Program tab, the following window pops up.
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Kit Operation

Figure 3-9.  Select Debug Target Window

Click on Port Acquire. Click Connect and then select OK to program the device.

Figure 3-10.  Program Device

13.After successful programming, a prompt message is displayed in the output window (see 

Figure 3-11).
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Kit Operation

Figure 3-11.  Successful Programming Message in Output Window

Note Refer to Example Projects chapter on page 19 for more example projects.
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4. Hardware

4.1 System Block Diagram

Figure 4-1.  PSoC 4200 Family Block Diagram

Features

■ 48-MHz Cortex-M0 CPU (0.9 DMIPS/MHz)

■ 32-KB flash and 4-KB SRAM

■ Programmable logic: Four universal digital blocks

■ Analog blocks: 12-bit 1-MSPS SAR ADC with sample and hold and a programmable sequencer, 

a continuous time block with two opamps with a comparator mode, a temperature sensor, and 

two low-power comparators

■ Fixed-function digital blocks: Two combination UART/SPI/I2C (one function at a time) serial com-

munication blocks (SCB). Four 16-bit counter/timer/PWMs with center-aligned capability
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Hardware

■ Fixed-function special blocks: CSD CapSense block with shield driver for waterproofing and digi-

tal LCD drive on all pins

■ Clocking: Trimmed IMO and ILO clock sources

■ Deep Sleep, Hibernate, and Stop low-power modes

Figure 4-2.  CY8CKIT-038 PSoC 4200 Family Processor Module Board

The CY8CKIT-038 PSoC 4200 family processor module board has the following four blocks:

■ 44-Pin TQFP package PSoC 4200 family device 

■ Four 2 × 16 headers, which connect to the CY8CKIT-001 DVK main board 

■ CMOD circuitry for CapSense application 

■ Single-wire debug (SWD) connector 
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5. Example Projects

All code examples provided with this kit are for the PSoC 4 device, CY8C4245AXI-483. Make sure

that you select this device when creating new projects using this processor module. Visit http://

www.cypress.com/?id=4519 for more information about the PSoC 4200 device portfolio.

5.1 Project: VoltageDisplay_SAR_ADC

For all the projects, place jumper J12 on CY8CKIT-001 in the LCD power off position.

5.1.1 Project Description

This example project measures an analog voltage controlled by the potentiometer. The project uses

the internal SAR ADC configured for a 12-bit operation; the ADC range is 0 to VDDA. The results are

displayed on the I2C character LCD. 

Figure 5-1.  VoltageDisplay_SAR_ADC Schematic
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Example Projects

Figure 5-2.  Project Flow Chart

5.1.2 Hardware Connections

The I2C character LCD should be configured as shown in the following table.

Pin Name Port Name

Reset P3[5]

SCB_SCL P4[0]

SCB_SDA P4[1]
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Example Projects

5.1.2.1 PSoC Creator Connections (VoltageDisplay_SAR_ADC.cydwr)

5.1.2.2 Physical Connections on CY8CKIT-001 DVK

Because it uses the potentiometer, the jumper VR_PWR (J11) should be in place. This connects the

potentiometer to the VDDA. Connect the output of the VR pin to P2[7] (Voltage_Input) input pin, as

shown in Figure 5-5 on page 23.
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Example Projects

5.1.3 SAR ADC Configuration

To view or configure the SAR ADC component, double-click the component in the TopDesign.cysch

file.

Figure 5-3.  SAR ADC Configuration

The SAR ADC is configured as follows:

■ Free-running mode of operation is selected because the ADC scans only one channel continu-

ously.

■ Sample rate is set to 100,000 sps. The code waits for each sample, processes it, and displays 

the result on the LCD.

■ Range is set to VSSA to 2*VREF (3.3 V) in single-ended mode because the potentiometer output 

is a single-ended signal that can go from 0 to VDDA.Therefore, at 12-bit resolution, the ADC 

resolves in steps of VDDA/2.

■ Voltage reference should be set to VDDA/2 supply voltage when the input range is set to VSSA to 

VDDA. It is set to 1.65 V here, because by default the VDDA jumper setting on the board is set to 

3.3 V.

When the VDDA jumper on the board is set to 5 V, set Operating Conditions in the System tab to

5 V as shown in Figure 5-4.

Figure 5-4.  Operating Condition
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Example Projects

5.1.4 Verify Output

Build and program the code example, and reset the device. The LCD shows the voltage reading cor-

responding to the voltage on the potentiometer. The following figure demonstrates the functionality.

When you turn the potentiometer, the voltage value changes. 

Figure 5-5.  VoltageDisplay_SAR_ADC Project Demonstration

You can also verify the voltage on the potentiometer using a precision multimeter.

Note The potentiometer connects to a differential ADC, which works in the single-ended mode. This

means the ADC input is measured against internal VSSA. Any offset in the measurement can be

positive or negative. This can result in a small offset voltage even when the potentiometer is zero.
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Example Projects

5.2 Project: IntensityLED

5.2.1 Project Description

This example code uses pulse-width modulators (PWM) to illuminate an LED. When the pulse width

of the PWM varies, the LED brightness changes. By continuously varying the pulse width of the

PWM, the example code makes an LED go from low brightness to a high brightness and back.

Figure 5-6.  Intensity LED Schematic
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Example Projects

Figure 5-7.  Project Flow Chart

5.2.2 Hardware Connections

5.2.2.1 PSoC Creator Connections (IntensityLED.cydwr)

5.2.2.2 Physical Connections on CY8CKIT-001 DVK

Connect the output pin P1[5] (LED) to any one of the LEDs present on the CY8CKIT-001 DVK, as

shown in Figure 5-8.
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